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FRE R/

| (=3 845] |
(DT BERPERDZRL,
(2)% 5 Keil 44T L3R5,
(3)% 3] Proteus 45 L2 3%,

AT 51501

PR ML, BIVACRE ) 25T (microcontroller unit, MCU) , 5% FH A8 K AR 4 Bl e P50 AR L
A K s FEEE F7 ) S Ab BRER (CPU) | ML B4 45 (random access memory, RAM) , H
BLfEfifif (read-only memory, ROM) i A /i 1 4% 1 (1/O 452 111, AT GBI A0 45 5 1 % /114
f AT A B 0 B 5K ) 6 (LCD 5 LED 3K 8 f #%) . ik 5% 34 1 (pulse width
modulation, PWM) Hi [ 451 22 B 5 4 2 SoBE /00 (A/D) 4 g S i e, 42 pli 31— Huth
AR AN FE T RAAL R S .

B HLRE NS B 57 B Tl A5 i I 57 044 RE AL 4 I D RE 3% R 7 LAY — K
B ALA B I R G S T R el R AR BOR A — R A ) LR, I)L,f
B HLT Iz N TR R AR A L Tl 45 i 5 HL AR TR HLIN 28 i AF | BE iR A A
it

1. S e FR LRI A

B HLEA RN IDARAR FE 6 DD RE SR B RS R A A AR AL S5 B A

RAY WA IRAS , T SCHLA F  D)o R  BE UR B R R R R K VR LT
%rﬁ%MMa K FHER AL ARS8 SOGR B R e Ak LAk, H D) REAH Lk 5l
SR FHASE A0 B8 507 v I8 B3 A, AR ) 3 P A 28 I o A A, I AT R IR L £ A b
(E

2. FE Tl =l Fh B9 Rz R

R HLAT AR R 2 HE R R G B R EE R G N T K& B ae s
PR RE AL ] AR R G DL ST RS S s i R S5

. EXRABFEHINHA

IMAER FZ LA FEA AR A T 5 AL ) A O B R ARHIL L H KA L5 T8 R LA

4. FE 1T E AR 28 F0 18 15 g 9 Rz A

A (E A AR ARSI T B A WL e L TR SR T ML AL LN AR S HR AL
P A Bl AEIE I RS S IS RS, 02 H o TAE R AT WA SERE R a1 . T
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2 X PFILAE
5. EERIR& PR

BRI BE FHBE & (0 s A 24 )32 B AL L 4% A4 AL W AL ER A 2 e
BEE B R R 5855,

WA, PR R HLEE TR 4Rl RHIE O B B LA K SR 5 T 2 A

T L R LR L2, 45 B, 277 A MCS-51 %41 . Motorola 23 & Y 68
Z %1 \Microchip 2V & PIC16F/18F 2 %145, MCS-51 2%t T4 # %5 Intel 8031 54 24
15 R HLASGERR L U8 T Intel (1 8031 ML/ ML, J5okBE#E Flash Memory 4 R [ & & , Hak
S )2 0 8 R L — , HAR R AL R Atmel ARIAY AT89 F51 . Intel 28 7l
MCS-51 B F AR BAL L A 7 5 AR 2220 W R i J2 AN ) 0 7 SR 4 T D RE IS A AN R F
MCS-51 RAFIFHFAENIL . BagEE A= RS IR,

(D Intel:80C31.,80C51.,87C51,80C32.80C52.,87C52 4%,

(2)Microchip:89C51,89C52,89C2051.,89S51.,89S52 4¢,

(3)Philips. 3 . Dallas. Siemens(Infineon) 25/ &) B Z 77 5

(D B 7% b STC B L.

Horp, STC 5 LLAHARIOAE B e i bERe . 4 E W 51 SR HLIER KT .

Ok I — AT RSB R A AR BR R AL, B 1-1-1 s SRR kT 48 il v o
R A STC12C5A60S2 Hu R #LEE ] 3 AN F A LED KUK IN KR  INARESS ] [R]F >A7 500 ms.

T ) VDDSV RSLI LEDI
X1 o2, x2 r 39DI i ey & X 2
1| r PLO (ADO)P0.0 (3337 2 k20
11.059 2 MHz Ll (ADDPO.1 [—=5s ¢
P12 (AD2)P02 (722 4
P13 (AD3)P0.3 = 5
==cxi =—cx2 Pl4 (AD4)P0.4 | —33 D4 6
30 pF 30 pF PLS (AD5)PO.5 |—34D3 7 P21
PG (AD6)PO.6 |—33 D6 3
P17 (AD7)P0.7 2 D7 9
P3.3(INTD) (A8)p2.0 |21 P20 5.1K*3
P3.2(INT0) (a9p2.1 |22 P21 P2
(A10)P2.2 ;j 25 -
GND P3.5(T1) (AIDP23 2 3K
P3.4(T0) Eﬁg;g-g 5 RW
Zvp TR 3; Lep.cs - VDDSV
(A15)p2.7 |—28.F=
BXTALI
XTAL2 veel—5 o
RST RXD)P3.0 (—19-R¥D
_ (TXD)P3 1 | GND
P3.7(RD) ALE/PROG [t
P3.6(WR) PSEN p—=—"

STC12C5A6082

1-1-1  FATI=H B

MEEHL I, LEDL \LED2 \LED3 [t 43 il 28 B i B4 2] P2. 0.P2. 1.P2. 23X 3 >3]
B IEAREREES] 5 V B E b, B S BR BHL P2, 0. P2. 1. P2. 2 2] % % B SERd . LEDI .
LED2,LED3 s, R, % 3 A4 LED B2 K35 5 B3 i 76 A N A0 5 | G L 5 e 37
SRS B4 5 B B WL R R R P2, 0.P2. 1, P2. 2 5| R ki 4 4L 500 ms (K HL -,
SEHR 3 A~ LED AR N » HLINERESE] ] A 500 ms,

F e 3R, i DA 2R AT #  TAR AR, an &l 1-1-2 B,
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[ o]

AT
P2.0=0; LED14%
P2.1=1; LED2X
P2.2=1; LED3X

Y
FERFS00 ms

!

P2.0=1; LEDI’X
P2.1=0; LED2%:
P2.2=1; LED3X

'

FEN}500 ms

'

P2.0=1; LEDI’K
P2.1=1; LED2K
P2.2=0; LED3%:

FERFS00 ms

1-1-2 ZATHEH TERER

T A S5E LED s 6 B Y, o i N 4018 5 A C51 1B 5 OoRSEE ., LUsS5E LEDL
B A G ARSI R,
s T #¢ : B 7% LEDI
ORG 0000H
AJMP MAIN
ORG 0030H
MAIN; CLR P2.0 ;LED] =
END
C51 PR an T,

# include<Creg52.h>  //& &4 5k oh 6 57 77 85 8 SCHh Sk U
sbit LED1=P2°0; //J sbit x4 5 & X LED] £ 3 %] P2.0 3 H

void main (void) [/ AT =/ CREFH LA AR A — main g %
{
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LED]1=1;
LED] =0;
while (1)

void main (void)

{

P2 = OXFF;
P2 = OxFE;
while (1)

{

}
}

SRIG A SE R AR SEELNT 3 4 LED SR INMRES S I g AL i R .
s T Ak 3 AN LED R 0k A Bk

ORG 0000H

AJMP  MAIN

ORG 0030H
MAIN. CLR P2.0

SETB  P2.1

SETB P2.2

ACALL DELAY500MS

SETB  P2.0

CLR P2.1

SETB P2.2

ACALL DELAY500MS

SETB  P2.0

SETB P2.1

CLR P2.2

//¥ P2.0 bR 1. 4 i P
//¥ P2.0 O AE O, %y th (K B F

[/ER N FE - TR

//P2 1 &Hp K T
//P2 B i R ARAL &

[/EE N FE - TR

;LED] =
; LED2 X
;LED3 K.
; ZE B 500 ms
;LED] X
;LED2 =
;s LED3 X
;s ZE B 500 ms
;LED1 X
;LED2 K.
;LED3 =



DEE D |

ACALL DELAY500MS ; ZE HF 500 ms
AJMP MAIN
DELAY500MS; ;@11.059 2 MHz, ZE ff 500 ms
MOV  30H, £17
MOV  31H, £ 208
MOV  32H, £23
NEXT,

DINZ 32H,NEXT
DINZ 31H,NEXT
DINZ  30H,NEXT
RET
END

C51 FEFPARRS AT .

# include<(reg52. h™>

sbit LED1=P2-0;

sbit LED2=P2"1;

sbit LED3=P2-2;

void Delay(unsigned int t); /)&% FE W

void main (void)

{

LEDI=1; /AT

LED2=1;

LED3=1;

while (1)

{
LED]1=0; //LED] =
LED2=1; //LED2 k.
LED3=1; //LED3 K
Delay(50000) ;
LED]1=1; //LED] X
LED2=0; //LED2 =
LED3=1; //LED3 &
Delay(50000) ;
LED]1=1; //LED] X
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LED2=1; //LED2 X
LED3=0; //LED3 %
Delay(50000) ;

JE I o 2, &0 i N\ £ 4 unsigned int t, TR FE(E
unsigned int & X EAF 5 ¥ A R &, KW 8 E Z 0~65 535

void Delay(unsigned int t)

{

while(——1t);

}

W FARRRFAE AR 51 B LA AT AL b L Gl T 2 TR R # B R B AR Y
REFFAEAfas i) o e i b el s BROR MLEI AT e IR P gUf T . #2246 LEDL, LED2 . LED3 4RI IA
K« INVBRIRE 1] (B8] B 28 500 ms

MR 57T LLUE B A R MU R G 75 ST B AL A BT P g A
I FL S 3K H5 R B LB R R R 5 I T B TR R HL AR T AR 7 o 3 90 S B 7 BIL Y 4
IR IREL . HET R 3 I RE AT e SRS AR T e R AT /e 4

S HNBNRG

R HL S RERS (L T AR (4 /N ] R B S B BILAK) /N R 4 A R Gt el A2 0 4
] Rt b =38 7 S L LIS

1.2.1 REHtAEAERK

X FALAT—A M F RGP, 1 2 ) A2 e R Ge it fEep v 1)
Fa e v S JE RGP Rs AT RTHR AIERE . A Se i R ML F R G Z R Ah AT
PLbsh 2 H BURE 7 R I B , T ol A B AR I 1 — A BT B R
PR AL RGN B — R T AR A R AR

S A AR 2 B0 7 LT R AR USB 2 11 i Fn g s A e
VAL R P AR (L AP R (b s B . B, RIS R AL T AN A A H L Y40
5V M3, 3 VIFFRAE., AR STC89C52 M HHIERT 5 V iLebrsE, il i — ik
ANEEE AR AR F LN 3.3 Vi FLBRvE B9 R L AR 45 T R G 2R Go it e Fi B R 4R 40L 5
Vi iRAE3. 3 V Eil . REH i  EmE 1-2-1 FiR,
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7-12V

Power_input pex =
1 7 1
i . . VDD5V
o 3 o1 -I_CZ %‘4 é Vin feedback m T
i 470uF/16V gnd output
HEADER 2 GND | T I 3 and on/off [—> L
GND  LM25965-5.0 D2 = - |C§4 D3
IN5824 Tcs 62V
220uF/16V

R1
L5 L cn 1K

LM1117-33 ™ 1op/i6v T 104
a DI
\\‘\ RED

1n4744a-15V-1w

OUT I

—4C3 —C7
™ 10uF/16V =T 04

)|

N_
é o
2 6
w
7
2
(o]
>
)
|:3 IN

|
(=)
¥

Z
o
9 PN 9%
Q
2
8 T
9
Q
z
o

USBOTG
w =

GND
1-2-1 RGHEBEERE

40 IR A B R L, B YRS | BEIE: 40 JEIFD 20 J1. 40 B +5 VLl FR o VCC B VDD,
RFHE FYR TE#L 5 20 B4 S % Hh % PR GND 8% VSSACER ZRIER Tk, VCC I
GND 2 [a] — 4 A— AN uE P s 25 H T U bR E i 13t .

1.2.2 Ef(rfEHBE

TER R IR G A S A R AR O . R IR AR TR E S . 4
TR HLAE T P B BUAEHL A5 R DU 3% T TR $2HL TH BB P B AR P DA Sk O I R R
1o R AL —FE YR T HLR G AEIS AT IR B 7 A5 R AME DU #2 F B L H L
PR A S MR EF AT . 3oh, M R HLAR GEEORT b R P2l R e o i F 3
SR T . 2 P R g mT by e A | e B A ER IR PR A A B TR 1-2-2 R

C3 + (IOHF
L frsT
17 ==
S s Rk TICRI Pk
SW-PB :'j__

STC89C52

1-2-2 Efri=HlB %

WLEEERL I 25 LA I N RE AL " I M mT LUK Y R 58 b s i, RST 2 i 3
e L AP I XA e PR A IR Ty RS RLC{HERSE . X T LRI R 51 5 L. RST B4
F el FEL PR P BILE RS Al nRe B R LA AR A . BT LA 415 RC R HRUE AT
PRAUERT SE 52 A (R Dy 10 kQ A1 10 pF. R R HLRGE T . R G0 LS SR S 37—
UGHRO LB . RGBT B WERE N B AL AR R . SRR S
RST R3] 5 H P TR 5 7 ILSE AL it S 442 1Ll 85 T LA B e 3 B8 7 LA
ENECT P
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1.2.3 B$hEEE

P o it g B AL AR e (R M I B (555 B AL P T A i B A LA XA I b 5
AR REEEAT AR . STC89CS2 H R HLAY XTALL AN XTALZ 2wt gh 518, 5
BT LR FHANER A A Sz N2 5 5 VF Dy R GEIE B et kb5 53 i XTALL B A SR B
PR o A — B B R BIL P9 P AR ) e b 7 A ri R AR AT R ST I b, X IS 224 XTALL
AN XTALZ B2 )5 —A~ i AR 7 i (b ) R P 500 A P B

R R HUT KA R G B 11, 059 2 MHz 5 12 MHz, JXHURH] 11. 059 2 MHz
IpA JER BR AN 1-2-3 P, AL oR FI AU 11,059 2 MHz ik . ISR 8 33 pF,

— =< P3.3(INT1)

33pF) CL, :i<> P3.5(T1)
o —2<> P3.4(T0)
Yl 31 —
GND n|||—< 11.059 2 |[VCCH———<>1 EA(VPP)
339F ) €2 18 . [
| xTALI

1-2-3  E$hEL &

1.2.4 FEWOEMZEMBERF TE

PR AIUIE S R G R H g A AN o e S R S A e A B B /N R B S S BT AE T4 o R
J¥ AR AGEIE N H . B R ML H R G /N R G2 LR B InsZE (0 A0 Bl e % . H
() 5 R HILIE R AR — M F e . LED  LCD MRS 2% L H 1145 /NI H . AT 1R AT 8 1 &R
gt , HAME R 3 4> LED K HIRS . AR EEE 1 SRlisk 40— 2o oh Bl H2 10 fL i &
H S AR R

STC89C52 ML/ ML LR FH 8 AT RE 17 T 38 X OM P PR B4t T B R R, 3 F
KB TEAA FARRT F NIRRTy TR R 8 O, T i 5 i 0
HL %, G & 1-2-4 7,

JCOMI TTL Jrx d
—TtxD T__RXD
»|—RXD »[_RXDC
_BEK CON2
CON3 GND
cls U8 VDD5V XMPCIIE, 2oL, 3Kk
com
E —ci+ vob |16 o AN
104 3 2 C17 6
Cle Cl- Vi =50 RX 2[5 ° | BoI
4 6 Cl18 7
E‘ 0|—4 C2+ V-— 1704 X 3 15 °[B02
5 5 3
TX 13 | S 11 T=p > C\D T 5° v
14 2 RXDC 9 ] GND
RX77TIOUT RIOUT |3 21 o
— 7 I720UT T2IN 5
— 8 IRJIN ROUTPE— \ e
GND RS232

SP3232EEN/max3232
RS-2324% 11 H £k

1-2-4 EOHEOBR



DEE D |

B 1-2-4 B R i max3232 SEELHL R HLER 1 TTL P51 HLE 1 2 ]
HREHe AR AL 1 REAS @ RS-232 42 11 5 80 HLE T 473815

FEXT R WL AR T AT, B Se kA 5 HLN FH 2R 4 04 B 3 1 (R TIE B 4R R
s R R 2K s R LT R ST R E . BP T e Ry zﬁﬁ%éﬁMﬁFéﬁﬁéiﬁi
FIPLASAS SO CRI. HEX SO F 881 5 AL R P A =S o). B)7 TR 81T ZEfIth
STC-ISP ¥/, #)7 T4kl FRan T o
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bt uis B« Cimgsrsms  CezmeEss S0( <) Fac
bx0000 [V R EREAE HFRRET
[fxz000  [7) ERSEEPRONE ML $TIFREFRONSZ o5 TiFED) iFFasiEl SR EEFROM L0 ERER Eﬁl‘
= =7 = el STCISFZEDASZ. 5538 8K 2048 53K 42 3 =

R | paTa | EmEEtn R ||| oo sesa o a6 e e s |
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] B S 2800 B SwiSEKZsz | 5538 3N 2048 2R 42 B
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7 FERir ERAEIR SICISTIKESZ 5.5-3.8 4K 2045 13 42 &

¢ SICISEZKES2 5538 SK 048 5K 4z &

il M-?MFEHFN izl L SICISFZHEOSZ. 5.5-3.8 BOE. 2048 1K 42 B

Il T4 mahed, p1. 0/P1 100/ 0 AT T RE R TAPISTZIEIS? 5538 BIE IdE TN 4 B

(7 TR T3P P2 R R FIEEPROMEE InCISPEKESSZ 5538 B3SK 2048 I 42 B =
[ EENR e Ty = T
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o[ B-SICIFB0EE F31 - TeE
RO [ STC12C52044D 51 :] —
BifgigE| B-SICIZSEI6AD 25 : ImﬂE_ kﬁ;l@_v smjpjx-* - | To#E : :
e ] B+ CimarEs  Casabmss A0 o Do
[px0000 [ STCIOCS1RE ,¥~£\JJ HIFHERFI
- STCAOCSERH 265 = =T e .
B0 | & Srcoranan ?\J [[FFEERRONITIE :ﬁ; - Iff_fém kﬁ[f@ :::: EE:;DM I:; Eﬁfg SI_\
: - STCRACSIRC 5 il SFZRDRSZ. .53, I
il ey i | WU sreieronese | 5508 R 4 ek &2 s
o e i+ STCASC/LESZRE = 1c 5538 20 2048 3K 42 B
= - STCBAC/LESSRC SICISF2K24AS  5.5°3.8 24K 2048 E 42 6
| & A STESQC;IEBERC 3 SICISFZEIZS? 5538 32K 2048 2K 42 6
L=t e SICISEZMAOSZ 5.53.5 aE 248 2K 4z 6
] FIERd . STCBYC/LELZRC SihbIanE. - b A AR S A LR 4 o
(= Azgy| -STCRACSERDT EH| gtmg : igg ﬁ x: :‘g :g- :
[C T2 TR, 1 O7F1 TR0/0 A [4#12 % Desmels  s5as  BE e DE 42 5
) TR TR PR FrRd R A FEEF RN E 5538 B3EE 2048 TAP 42 B =
| fE B ERR SRS oo o o 0

Ti aac/}'_'i'a'z_lif

2 a1
— E% §? Iﬂﬁ-ﬁfgfaggﬂ%ﬁ"ﬁggﬁﬁﬁ
T/ =ik EEHE
N EEUM[3 ) e —

SATHAERESEI -
IS E RO R RE TS (Emner [Ennas) [FREens| ViasE muni s

1-2-6 EFBRYES



| a5y EERSHA

T,

PP — KR LS )5

B SRR T

5 STCISP (V6.67C) (SE1%: 0513-55012028) Eiwww. STCMCU.com (HH4MIEQQ:200003751)

 STC: ehpms.. [ ]

T#RE s EERE

[ womcvam | [Emmm| =SB -

& S 4218 | STCeEC/LESZRE |3l (ante -] [FOBE [reafBns |EeEE | AEARHAS [EEETES [ EhE
a|0s| 5 = - 353
Sfipits| | -SSR | k[ o || LIPRE[ v BEmEk v smkoh[s o] @R o]
PEm gabetating = * Clmssamns  OasmArass 2ok -] Hac
0000 ---STctzcsmn%Z i TR
| @-SICISFZER0SZ Fbl =l o \ 2y i
ey gl T — e N Mo
wm | ® % = FORISS2 5538 ST S| E
R | imienes 25 A ||| soisprese ssss | ik s | sx 2 6
[ eea] & STCISHLKIES 25 g SICiSP2R2SZ  5.5-3.8 24K 2048 K 42 B
M) e SICIS0ES 25) STCISFIZGS p e A 4z 8
[l BEARHR - STCLSH08AS 31 SICiSERKRS?. £ ST S
B L el SICiSF2RATS2 WK 245 K 42 B
7] PS8 & stiorioeE 25 STCISFZRAESE 48R 2048 IS 42 B
7] aregp - STCISF204EA 5 SICISF2IERSZ S6E 2048 5K 42 B
= . e STCISF2HENSE. BOK 048 1K 42 B
[ T4 iR, F1C0/PL. 100/0F o] g R TAPISFIIBISE S e
(] T T P A P R PROME FOHEISE BISK 2048 I 42 8 =
[ FEBERS ERS o T - T

RS

*z %T‘.H m »f g
%% ta‘éﬁ mq‘i%flg e s

BT HAETEH BTN
C SRR e B E T Hms

[pmREER| (AR ERsNEES] VETE dontg ss

1-2-7

BETRERES

() PEFEA RIS 5 T gkt COM [, 2“8 157 FRigl bk s fyL 5l
FERGE 1 BT STCISP ARSI 5 2> A st , - s a2 A PR WAl 1-2-8 R,

5y STC.ISP (V6.67C) (BSEi%: 0513 55012028) ERwww.STCMCU.com (FRATEIQQA00003751) — STC: STREAAGS.. EM

£ H4 32 [SToRSC/LESZRE | 3l [Aute =)

| %DqW&-&i%
EREHE Egﬂé o
bl
D000 'ES#E e |
pxz000 'SERTAL CH340 (COMLO)
TE IR cnmé TR
— comi3
B '
I} Biﬁ:}ﬁ CUMlE‘
7] s o 3

U | (] Fa&pdr ERAMET R
(7] ALERNRE fEP4. 501
l (7] T B, B 0/R1 10/ 0 AT 3R
(7] TR T3 4% R R A FREEEROMEE
[ fE B ERS ER S

T/ =ik EERE

[ mecssn | [aEmm| SEWiED o

AT HAETEH BT
[WE =t e i ey e

| S08F |xeapEns | TR BE AR | prEitEs |amide )
R
TreeelE(x vl Rzl vsuukh[x o] w8k o
T CmSese  CashrEss B0k - M
ne TiRE) e s mRon 10 EHE 8-
StrisroNEs? | 5538 L e
SICISF2KIBSZ  5.5-3.8 16K 2048 45K 42 B
SICISF2EZ4S2.  5.5-3.8 24K 2048 37K 42 B L
STCISFZE24AS 5.53.8 24K 2048 JTK 42 B f
SICISFZE32S2. 5.5-3.8 3R 2048 29K 42 B
SICISF2R40S2  5.53.8 40K 2048 21K 42 B i
SICISF2E48S2  5.5-3.8 48K 2048 13K 42 B I
SICISF2EEESZ.  5.5-3.8 5BE 2048 5K 42 B
SICISF2IB0SZ. 5.5-3.8 BOE 248 K 42 B |
TAPISFIRRISZ 5,538 BIE 2048 IAP 42 B
IRCISFZKE3SZ  5.5-3.8 63,5 2048 I 42§ UM
4| 1 | » I
= — —— |l
SLEAIE . STCSAC/LESZRD - I
*Egﬁ ﬁﬁ;’é El L i W
'_F_' I e F T H-FTH
£ éa?ﬂ%‘i%?gg e h et
[(sAEEEE| [(EAREED FREnEas] FEns My so

1-2-8

% COM O



MRBEEY Fpl=

L ARBEA A S BN CIEHE AR O AT R T AR SRS BEHAS , ml STCISP SRR RAS
ﬁIEI’JXHﬂL BT A AR S ST TNV B S Ve B A PEAR . AN T&] 1-2-9 P,

e ————
gﬁﬁaﬂ -l a - (=[5 |
XHE E®EA FEV EEH
e»|2EHE I
& ) 45 WIN-QFNQHKNOUFP B
a | EHIE b+ Bluetooth FEERE KA
» @ EEiRE b L} DVD/CD-ROM Hizes EzEn ¥
- @ PHESE b g IDE ATA/ATAPI &5
> G Sk b Jungo
R o [ aEE
@ e b BEETE
(& EEEEs b < TR
e =1
= mEEE b T &0 (COM 1 LPT)
b By BSARRES b T
I
(R 4
b ] AR
o[y HitinE
i Bluetooth SHEESE
b Uy AEENEE

[ e——
» T EeRE

b & TR

b EsEE

b & SrEEE

1-2-9 FTF“REEIER"
FE U 73 T B B R & i, W P St

I 1-2-10 B % - 3% L0 A AG £ 101 45 9 COMILO, S comg

BRGS0 £ R A B R |7 s oo o

R U R A R A B F | em

AR S AT ST e e o
(o R et e 10 LT b 5600 11

BT AT IR P SCHF " H L e PR AR 2T S Ry - Al 1-2-11 o,

55 STCISP (V6.67) (MR 0513 55012038) BRiwvw STCMCL.com (FATIEIOQ 800003751 NETC. S Rus. i i=h |
3leph hato ~ | [EOEE | BB GE | GAIER | AL/ (/AR |nEnEs | ahad 1
mmzm Faats nmn_ o) o o A o P o P e
H+  COnFsEEns Dezmsess a0k o) D
Exoooo ¥V St FIHRRE [
frzms [ : e TEE() BREE SN DPRON L0 ENE A -
M - e [T TR R e e S e e
WA | BT | EENEE S [ EEE | || sommrese | 5598 w6
(] feee ARt < ||| || S N A T
= o q ! B[S 8 24K 2048 3TE 42 &
(Y ) g 2% 048 29K 42 B
7 ST LS T e ME e 6
V] FIERT FRERANEIF :g m 4: Ol
= B 2048 42 &
DM{EWW‘EM 50 y BOK 2048 1K 42 &
(7] T BEhRe, F1 0/F1. 100/ 0A BT 8612/ APISFZNBISE. BIE 2048 TN 42 6
[T TR T4 P FrB 2 FEEFRONE TRCISFZIEISZ. &m@ B35K 2048 IR 42 & &
) i ERER EFS Thesi= e
t B8 . STCHAC/LESZRD
*%Eﬁfﬂzm ﬁ
D 1D (| M 3 F1H-FTH
: = %%ta‘:ia? q"%;ggf? e
[ Tmme | s [ EERE
e -
DS AT RS SE
S e B R T [EmmEEE (EanEm) FRiEas| Vigns s s

1-2-11 EFERBETHMNER



| a5y EERSHA

(O) Bl T 8/ e 4L, N AR SO . B

FRHL L, A 1-2-12 s

WSS R R B/ R L A

5, STC-ISP (V6.67C) (EFam 0513-55012628) B ww STCMCU com (ATIFIQQ800003751) — STC. Bipatins.. | =l e |
S (Sroeec/isene =) 3l (huto =] [EROEE (Kl fhEieE |mpies: | 2 T/ P | et B | s
N
Bff4E 2400 ~|  BEEBE (uszm o Iﬁ%ﬁ RFz 'EJ- S“’”"J" IE@5@-
A2dadht T - CimipstEey  CESRHEESS S0 «|[Cac
bxooon [ ERE ARSI IR
Pxzo0d (V] EERSEEPRIMENE FTFFEEPRONZE S T{eEE (V) #2FEZ5E SRAM  EEPROM I/0 SERIE 8~
| e e cisk ssas e we sk & 8
I WA | T | St | Els | o T e I
1 fpeeT GRfREESE <||| || Srasrzezase.  s.sas o2 mas wE &2 6 i
i STCISF2R24AS 5538 24K 2048 3K 42 L8
(] BRAR SR A Swisrees?  S538 w2 42 8 |
| | |7 oeemama Stoismmz | 553 A0F w068 2K 42 6 I
| | |2 s maamgen SiciskzeEse 5,598 43 08 1K 42 B |
[ ALERIFR{EP4. 501 SICISFRNSESZ  5.5-3.8 SEK 2048 SE 42 B
stwisimsz 5598 w1k @ B I
| | | Fs e, 21, o/e1 10/ TR | S e S
l [ T T R R 20 P FEER RO 1 IRCISFZRGSZ 5538  B3SK 048 IO 42 6 S|
7] B RS SRS T o e 0
I
MREAIE | STCR9C/LESZRD ” :
7T
J e -
1= ShFLH-FTH S
= 22 it %f}g R e
FHE PR T P e SRR meA L | -
i I EETEEE = T
T SRTHAPETEHE ——
S ER S  EE SRE TS (RUREER (RSN [FRANEES] TRFE ity 0

1-2-12

TERRF

(6) T 2l 2 B 1-2-13 P S .

5 STC ISP (V6.67C) (&7 0513-55012028) B Rl-wwwr STCMCU com (GARIEIQQ:800003751) TCTCIEIaaAs. [E=REe

2 oy 342 [STC890/ LESZRC. =] 3l [t =)
Ane s oun o)< 38

B (240 v BEEHE (uswm |

et
o000 [V EpR MR HHERT

Pxzo00 [V ERREEPRONE MR $TFFEEPROMITI
EEEER | BT | BRiE S | WEE |
T ke GRIFE) 8 &l
1 PR IR S SRR A 15
[T Ak ARl B E

(] pIFp EEMIETR

[ ALERIAR{EP4. 50

[ T bR, B1. 0/F1. 1 00/0ATT 8118
| AT #F AR A 5 A FEEFRONE

| BN SRS

m

[ Teme || er [ EZEEE |
| [zemm] weenb )

FRTHAPEFEREIT
WSt s pi= b -

TR [zersonicit | ROBNE [ kel (REEE [EPHER [A2/ itk aEs [ ]|
00000h El 05 D8 BS Bl BS Bl BS Bl BS Bl BS Bl BS Bl BS El. -
00010h B1 B5 Bl 00 BS B1 20 20 20 20 20 20 20 20 20 20 el
00020h 20 20 BS B1 00 BS B1 20 20 20 20 20 20 20 20 20 =
00030h 20 20 20 BS Bl 00 BS Bl BS Bl B5 B1 BS Bl BS Bl
00040h BS B1 B5 B1 BS B1 00 00 00 00 00 00 00 00 00 0O £l
00050h 00 00 00 00 00 00 OO OO 0O 00 00 00 OO OO 00 00 peny
000600 00 00 00 00 00 0O OO0 OO 0O 00 00 00 OO0 0O 00 00
00070h 00 00 00 00 00 00 OO OO0 0O 00 00 00 00 00 00 00
00080h 00 00 0O 00 00 00 OO0 OO 0O 00 00 00 OO 00 00 00
00090h 00 0O 00 00 00 00 DO OO 0O 0O 00 00 OO OO 00 00
O000AOR 00 00 00 00 00 00 OO0 OO0 0O 00 00 00 00 00 00 00
000BOh 00 00 00 00 00 00 DO OO0 OO 00 00 OO OO0 OO 00 00
000COh 00 00 00 00 00 00 OO0 OO0 0O 00 00 00 00 00 00 00
000D0h 00 00 00 00 00 00 OO OO OO 00 00 00 OO0 OO 00 00
000EOh 00 00 00 00 00 00O OO0 OO 80 00 00 00 OO 0O 00 00
000FOh 00 00 00 00 00 00 00 01 €O 00 00 00 00 00 00 00
00100h 00 00 00 00 00 00 00 O1 E0 00 00 00 OO 00 OE 00
4 il | +
B osFer {igdn waceH [ RiEs || BxEa [ #eEE |

MR ] 7

P1DAOPL 15 E

TR T P AT, ?FHF'EEPRDME

Al STCBAC/LESZRE

mERiE T
e | E
0\ H AR ELRUR F R V5] A \LODSE B8V LCD MR hex
[xwREER (runEme [FRAnEss) WRFE w4 [EE)

1-2-13  TFHRIHFR|

Keil S FF R4
ARM Keil I & ¥ 5 J2 ARM

25 ) A A AR ) i A SRR T R BR RL A

MDK-ARM,C51,C251,C166 Z£9F &% T. &, /3 BT Cortex fil ARM 2844, 8051, 80251,

C166 S5 dz il & i AT R

12



DEE D |

Keil C51 JF & T HICHEIrA 8051 fifA: ™ i, #2435t 738 Tl AnifE Keil C 4y 2200
S RS A PERY ST R 48 R — S T RE B K A0 EL A% S5 AE N I SE B T & T
H It Keil ¢ Visiond IDE AR X 48 T HA G 7.,

Keil pVisiond IDE £ BUEREE H 0y Tolk AR iE Keil C 4iikdshy 8051 MY L8t 1T Cif
B IR B T LAy M G R o . PRI AR RS T AHERA R MCS-51 15
#% R BAMNEI A5 (PCLCAN UART . SPL, 17 1/0 % F L A/D § 4 g D/ A 445 F1 PWM
ML) AT 2 35 0] IR BAR A GO0 ™ (8 A A 58 4 5 AU, F AR

PARTIR AT 1 R ) -3 7E Keil pVisiond IDE 4 BRE T Aol 4772 /7 51T,

1. STC & ERE

FEGtE e STC R4 5 AL AR P, a2 FATAT ) K09 51 5% 52 R AR HL. 7
FCgaiE 5 sk C i 5 X STC R G HL R HLAY BT FR Ik T BE 2 A7 # b A7 L. mT LA i
STC-ISP F#4ife T.HA STC #15 MCU /% Keil pVisiond IDE AYE %,

UARTFEAE Keil (1 Visiond IDE (s ZEH I STC #15S- MCU, RT3 00 N AP T .

(DFTH STCISP Nk e T2 Hofi 4 f4F STC-ISP-V6. 85, BE 4 “ Keil fij HI% & "1
T, Bk TS A5 Ak SRR Kedl 734, anfEl 1-3-1 fios.

| g/ asie | $OBF | ElOREER [mEHes | md i | s

| FESTELTERER. 1 | THBEERS

ST (i L s B K117 |
STC MenSUTHEGHRE

1. BENOSTCRMCUERI BT 3]
] Fei 1525 REAE T RUUVEY (REUVEERIVAL,
BT Ko H0ME) B =
( [T e e sETE) ] W55
[ Burs]  EelssRBE TR AR T ] %

3. EHISTCRYSLIE 5 R
] B KeilZ2RR(E TAICSL\THC\STC\ B R Keil C51 & 4
R

o FinZ  Cy EmRLA K lMREE R TACIER
Pim3 AR EEE R THART
e w2, W3 Wi B RPR—TFE

i e——
GHD GHI

SBCRrA R AR EAAIE
a&éjﬂéﬁéﬁﬁ%ﬁﬁ&ﬁ%ﬂ, ANEE A SRR MU S B i1
I3

1-3-1 1% STC 25 MCU iR E] Keil Hyi% & FE

C2) 75 ) “ 00 08 SO P A PP e - Kleil 2225 H 55 (— o “C:\Keil™) L SR 5 Bl
B E HR A AR STC RIS 1 MCU Sishdshin3] Keil #4550 Kl 1-3-2 JiR.,

? X

RSP

R 1IMFEE B (FlI0: C:\Keil)
(BF FUmAaCs1 HFH00v: B FFE)

—

{5 FFOutput
B3 htzqzyb2
-3 Intel
=)

-3 ARM

{3 Baclkup. 001

3

#-5) Backup. 002
B3 st
i) Eclipse
I v
#7h National Instruments b

> lE STC MCURLSERIRETH |

|~

[ m= ][ =m |

1-3-2  FRIhi N STC 24S/9 MCU 2l Keil iZ & EH

0130



| a5y EERSHA

2. B TRR
TN 2R anfe]fifi H Keil (Visiond IDE F & g% JRH PR F
(D A3 Keil pVisiond IDE, # A Keil nVisiond IDE %) 3 %L, a0 1-3-3 iz .

|E| U ¥isiond

File = Edit YWiew Project Flash Debug Peripherals Tools SWCS  MWindow  Help

NS da| % @9 c Bl R EEE G B e
A E R W NldB

—

Er..|@s..| OF.[0,71.

—

[Elbuid output | mFind In Files |

1-3-3  Keil pVisiond IDE g FFRH

() —H TR, PUT"Project” >“New pVision Project”fig 4>, WKl 1-3-4 7R,

[® u ¥isiond
File  Edit View |Ern]ett|FIgsh Debug  Petipherals Tools S¥CS  Window  Help

NS dd New pision Project, . @ fiee

g T TR Mew Multi-Project Workspace...
P aE Ll B 8

Open Project...

Close Project

Export 3
1-3-4 ENHFITIE

(3D 7 5L A XT3 HE T 3 38 3 I H B R A 19 B AR RN SR 44 IR AE BE AR E:\C51\
LED, 440 LED, s “fR A #40 BI AT . Keil pVisiond B3 H SO 44 4. uvproj, Gl
1-3-5 IR

Create New Project |z”g|

RFED: [ - e@mckE-

Eos iz gha= |

bras AR [rzn k2| fEe |
=l

{RTF2ER () |[Project Files B uvproj)

1-3-5 EFEFTBREHBREHEE

0140



DEE D |

(DO FRZErC it STCISP T #i 4w f2 T 2K
STC %5 MCU % hn 3] Keil (Visiond B2 FE S, Br L
T — AR 2 g & “Select a CPU Data Base Iél:et?ccg;ilal;a;:s;ase |
File” G CPU $48 5 XHEHE, WA 1-3-6 ffx, iz | CUEIEEEEES
TEHEH A “Generic CPU Data Base” G JH CPU 4z %) il
“STC MCU Database” (STC MCU ¥ ) Wi /M35, 1-3-6 GG EMIEE
WA PPl R B R PR STC 251, W% £“STC MCU
Database” , 8% J5 8.1 “ OK 41 R v]

(5) BEHR IR 5 B4 1 J5 25 3 1 “ Select Device for Target” (45 it 75 #4544 XF G HE , 40
&l 1-3-7 firon. PRRHEEE T “STC MCU Database”, i 43X B 9 MCU B S-4f 42 STC A5,
JH P o] 7 22 A8 808 31 22 (Data base) Wk fir i FH it AR B - HLAL S

Select a CPU Data Base File

ice for Target °Target 17...

Vendor.  STC

Device: STC12CHA6052
Tooket  C51
Data base
€1 STCIFOE Al [E rocantiole rwthﬂﬂ o k]thSp dC
€1 STCIFEORE V| ines, 2 Timers/Counters, 2 PCA Timers,
£ STC12C205240 il
ndependent Baud A Programmable Clock-Out,
£ sTC120520200 B0K. bytes flash ROM, 1250byt < data FAM,

£3 STC12C54108D On-chip EEPROM, 2 UARTs WDT_ISP/AR, A/D, CCP/Pywid
€1 STC12C561640 :
]

€1 STCISFI04E

€1 STCISFI 04w
£ STCI5F204EA
£ STCISF2KENS2
£ STCI5F408AD
€1 STCI5W04

€1 STCI5WIKIES

3

1-3-7 EFRESRH
(6) L - LAY S I P “ OK R HL - 25 ] 1-3-8 BTz B X TG HE , 1) 1) 2 75 K%
b 51 p1iHE AP (STARTUP. ASD IMATH . P 27 H 4. B2)¥ & A sh & il brifE 51
WIR AL AR P 2050 H T e B B AT H . — s T a5 7 He L.

\ ?J Copy ' STARTUF. 451" to Froject Folder and Add File to Froject ¥

& w

1-3-8 @B EBIRAE 5L MBHEFMATIE

(DTG5 tn] UT R SRR . anial 1-3-9 Bis . 47 “File”—>"“New " fir & . B it
SR R A ET AN 1-3-10 Fis .

W] E: \C5I\LEDALED. uvproj — U Visiond

| File | Edit  Wiew Project Flash Debug Peripherals  Tools SWCS  ‘Window Help
[T e, Ctrl+H R RER EEE G| e
& Open Ctrl+0 =

v & A —:n|

1-3-9 ZFELIB THEXH
. 15 .



| a5y EERSHA

BFEO s Ll PRRAR EEER @

< 3
De. [@: (0 0,1 &

Smuation, Licl

1-3-10 FHEXHEEHNFEE

BEIEARTE g 4 27 1 DN R S n] DU A P 4 5 B AR I .l AR P S ST
“File”>"Save As" 5% RGN K 1-3-11 Frs A, ?"“jdﬁFZ”jCZM‘EEF'%/\jC#F@,
[l A2 A TR e 40 . MR C 3B 5 4 5 Ry, W™ 44 0. Cs 2R Al i 5 9
BRF WY 48, ASM. ¥ RAARIING . SRIG Bl ORAF 1L

Save As

7]
BEED: 5w = ~BEsE
- ELD
) @] LED
HETA LA
L
HRTT
EHIE
ML
FHE@:  |EEE 5| BFe |
BFRE T [Al] Files Gew) | iy
|

1-3-11 REXHFRE

SO ¥e I R U i 8] TR b, By “ Target 17/ H Y+ 75, B IFJ5 i 3L Source
Group 173038, Az SCH e, 28 5 R BE S Fob % 86 Add Files to Group 'Source
Group 1'7g4>, Gnl&l 1-3-12 froR , 58 38 0 SO RIS AE 4 SO 28 B 3% £ Asm: Source
file”, n& 1-3-13 frzs . e SCF“LED. asm”, B Add™ 81, Bz S 2 T4 .

. 16 .



[W) E: \C51\LED\LED_ uvproj — uVisiond

FMIRBEHFH

Fle Edi Wew Projct Flsh Debug Perpherds Took SVCs window tie
NBd@ s @ rRBE®R IE | @ fee SRe @ oo a[E Y
L e | W e R
| [7teomsm | - %
(=30 Target 1 “ i
1 X
S options for Group ‘Souree Group 1, BAFT
OpenFile
[ Rebuid al target fies
(] gl target 7
add Grou.
|- Add Files to Group ‘Source Group ...
Remaye Group Saurce Group 1'and is Fles
T 0 p——

[ @ | O | — 3
Ielil| @[ U7 I\i\ Show Include File Dependencies : =
A Fies t2 curent Project Groug Simdatian Gici RPN

> e

2 1-3- [ Sz

1-3-12 AHREERBAFRE
Add Files to Group ’Sonrce Group 17 \‘?IIXI
sEEE0: [Sm =] = & ek E-
(e
IS
IR ) e file [k ok; % zro: &

B 1-3-13 B¥XEHRmEIERT

() HEG I E. WA 1-3-14 Fros, £8 “ Target 17 BA i, 45

Options for Target

"Targetl ' "4y 2>, BLHAT “ Project” > “Options for Target 'Target 1'” 44, KRGS M

“Options for Target 'Target 1'” %G HE, W& 1-3-15 B 78, 75 1Z % 3h
(G785

[ E: \C51\LEDALED. uvproj — U Visiond

Elle Edit W¥ew Project Flash Debug  Peppherals Tools 3¥CS  Window Help
MNMSsd@| & @ 9 renR
gl R P @ | W Target R AT
Alt+F7
Cpen Fils
Open List File

1-3-14

$%E$E“Options for Target 'Target 1' 654

HE s 5E H A ) B

17 -



| a5y EERSHA

Y, Options for Target ~Target 1° x|

Davizs Targst |Output|Listing|Ussr | 051 |51 | BLSI Locats | BISI Misc| Dabug | Uilitias|

STC STC12CEAE052

al (MHz): [11.0554 I™ Use On-chip ROM (0x0-0EFFF)
Small: variables in DATA

Memary Model:
Code Rom Size: | Large: B4K program

I~ Uss Orechip KRAM (0x0-043FF)

(KN {ER|E]

Operating system: [Nane
I~ Use multipls DPTR registers

- Oft-chip Code memory —————————— - Off-chip Xdata memor
Start. Size: Start Size:
Epiom Ram
Epiom Ram
) v
I Code Banking Start End
Banks: [7 =] Bankdvea: W OkFFFF

[ oK | [ camest  [[ Defwnis | [ |

1-3-15 “Options for Target 'Target 1'”XFiF4E

“Options for Target 'Target 1'"XHEHEF A L%, H T1% % (Device) 1E# . Hfx
(Target) J@ 14 it (Output) JEPE . C51 Jide @ M AST JwidedsJm P . BLST 44 s 1 A
R (Debug) JBPES(E B AV E , — MG N He BRI & /T,

T EF BN, — BB E TR g5 GE R P 3R LA A SO C HEXD , K2
B HEX AU, T LT F i E . ot “Output 73T R, % H “Create HEX
File” 5 BEHE , W& 1-3-16 s . iR 5 4 38 5 A= i HEX ARA5 SO CBRIASCHF 44 it B S
2 W AT LIFE“Name of Executable” SUAHE Hiiy A HEX SCH A9 S 22D By “ OK 7 #6125
WiZHE .

X

W, Options for Target ’Target 1’

Davics | Targst Output |Listing|Ussr | 051 | 451 | BLSI Locats | BISI Misc| Dabug | Uilitiss|

Select Folder for Objects Name of Executable: [LED

& Cigate Executable: ALED

IV Debug Information IV Browse Information

¥ Create HEX File  HEX Format: | ]

" Create Libra: ALED.LIEB ™ Create Batch File

(03 I Cancel | Defaults | Help |

1-3-16 FEERIFGEERERF B E RIS R4 (. HEX)

3. KA
BIEESE TRELUS - ol AT B . 72 LED. asm SCHF A LU AU

ORG 0000H
AJMP  MAIN
ORG 0030H

0180



WhREEY ZRl=E

MAIN. CLR P2.0 ;LED] 2
SETB  P2.1 ;LED2 K
SETB P2.2 ;LED3 X
ACALL DELAY500MS ; ZE B 500 ms
SETB  P2.0 ;LED] K
CLR P2.1 ;LED2 =
SETB  P2.2 ;LED3 X
ACALL DELAY500MS ;s ZE B 500 ms
SETB  P2.0 ;LED] X
SETB  P2.1 ;LED2 K
CLR P2.2 ;LED3 =
ACALL DELAY500MS ; ZE # 500 ms
AJMP  MAIN
DELAY500MS; ;@11.059 2 MHz, ZE B 500 ms
MOV  30H, £17
MOV  31H, £ 208
MOV  32H, £23
NEXT. DJNZ 32H,NEXT
DINZ 31H,NEXT
DJNZ 30H,NEXT
RET
END
4. BF HIFSEIK
BT oS e UG » T 2 T 5,
(DFEFHPE. HIT“Project”>“Rebuild all target files”#r4, WKl 1-3-17 =,

[@ E: \C51\LEDALED. uvproj — M Visiond
Fie Edt Uiew |Project | Flash Debug Peripherals Tools SVC5 Window Help

NS @ e @ ree YR @ 005 a[E] 4

Mew Muli-Project Workspace...

P E e
Open Project...
- x
—_— Close Project
£33 Target L =)
=3 Seurce Export >
»| 4 Components, Enviranment, Bagks. .,
By Muli-Pro
& FunTim
AL+FT
il 3
(£ Rebuild al target files
& Batch Buld
@ Translats E:NCSLLEDILED,ASM Ctr+F7 7 b
31 Stop build 500ms

[V] LE\Cs1\LEDIED wvpron

£ 2 Ciikeihcs 11ExamplesiHelloiHello.uvproj

i
Ep. |[@e. [ 1F 3 CikeilcsiExamplesiMeasure|MEASURE uvproj @

4 Ci\KeihCS 1R Tiny ZE xamplest Traffic| TRAFFIC. uvproj

e 5 CHKeihCS 1{Exemples| Blinky|BLINKY. uvproj 7]
Program Size  BCKelCS e\ CSAMPLE nvproj
sreapzng HSx 7 Ciikeilcs: %CB22\BOOST_LEDTSHEC ‘
TLED" - 0 En —
8 CHKelhC51|Examples| Infinean XCA364Alarm_Clockyilarm_Clack.uvproj =
9 CHiKeIhCS 1|Examples| Infinean XCE64\Binky|Bliky. Lvproj
Retuld alitarget fle: g i iExamplesiinfinecn HCBEEIBIkyBinky. ivorct Sidetion LIZCEE Zal |

1-3-17  $117“Project”—>“Rebuild all target files” 5%



| a5y EERSHA

é%ltﬂﬁﬂ_"fn,
R

SO R I, 0 B 4 1 it

HEAREF I, anfal 1-3-18

Rebuild target 'Target 1'
assembling LED.LSM...

linking.

Pr\tham Size: data=8.0 xdata=0 code=93

= ex file from "LED"™
"LED" - D Error|s), D Uarmingis).

Search for text

Simulation L:22 22

Cap NuM J

1-3-18

“Build Output”#i {5 2 57 ™|

ORI, $UUT“Debug”—“Start/Stop Debug Session” 4>, v A AR, A

K 1-3-19 R,

(W E: \CHI\LEDALED. uvproj — u Visiond

File Edt Yew Project Fash Debug Peripherals Tooks

SVCS  Window Help

NBSE@P| ) wBd(9c |« |prrn = U | @ e “ae([@ecce @]
% EHO Bron e Db REeR 22838 %-
|l umasm | =
Aagiater 1 ORG ODO0H =]
Er-Rees a 2 LINP MAIN
0 0x00 3 ORG OO30H
rl 0x00 4 MAIN: CLR P2.0 ;LEDI,E\_‘
2 0500 5 SETB P2.1 ;LEDZK
E 0400, & SETB P2.2 JLEDIK
o Pl 7 ACALL DELAYSOOMS  :3EATs500ms
= By a SETE P2.0 ;LED1;§
i 7 000 3 CLR P2.1 ;LEDZE =
< B N 10 SETE PZ.2 FLED3K
a 0x00 11 ACALL DELAYSOOMS :ﬂﬁSDDmS
b 00 1z SETE P2.0 SLEDR
=2 aar 13 SETB P2.1 JLED2K
e Exsl 14 CLE Pz.Z JLEDIZR
st 000 15 ACALL DELAYSOOMS ?lEB’JLSDDms
B dptr 00000 e AP MEIN -
states ) 17 DELAYSOOHS : :@11.0592MHz, FEHfs00ms
ses 0,00 18 MOV 30H, #17
Bl psw 000 19 MOV 31H, #2038
20 MOV 32H, #23
21 NEXT DJNE 32H,NEXT =l
I | ¥

[Eproject | Eregisters ]

Running with Code Size Limit: 2K
Load "E:%4\CS514%4LEDY,\LED"
LE (PORTZ & Oxl1) >> 0

>

Lacation/Value

Type

43N ASSIGH BreakDisable BreakEnable EreakKill BreakList BreakSet |

@castack + Locals [Evemary 1 |

simulation +1: 0.00000000 sec L:2Ci1 CAPLNUM .5

& 1-3-19 #EF

AR RE

(3)“Peripherals” 32 LN A ZF &I . “ Interrupt "3BT 0] LIS th Wy R Gk 4, “T/0-
Ports” $EI5 0] LWL 1/0 i PR , “Serial "33 0] LLWREL 8 ) TAEIRZ , “ Timer” 7635
AT LIRSS E B 25 0 TARIRAS , “Clock Control”nﬁiﬁ_fux}um WP B AR R . EAEI T,
FEEL 1/0 ¥ 1 J P2 v H PR ASE B Wk £“1/O-Ports”—“Port 27 &I, 1 E 1-3-20
B

(W) E: \C51\LEDALED. uvproj — U ¥isiond
Fle Edit Yew Project Flash  Debug | Peripherals | Tools  SWCS  Window  Help

NEedg| 4 =@ 9 Interrupt 5 ™ E N s | B Fres
1 1f0-Ports Port O

TE I = v l-m- =W

: SO, Serial Port 1 -

| ! Timer Port 2

1 Chockcontrol Fort

=l Regs

1-3-20

T£“Peripherals” 32 82 %+ P2 i

JERF B P2 3 A WEEE 1 “Parallel Port 27, 401K 1-3-21 FiR .

B 28 BRI
20

(IR RRPOE N



HRB R

D HALPIRK . Bl “Debug” 35, SR T RIS, A0k 1-3-22 P,

Parallel Port 2

Part 2

Pins: [0:FF [P e he

- 7 Bits 0
P2 RPN

Run F5
i @ Stop
| 1 sten Fi1
[| T step Over F1o
{¥ Step Out Chri+F11
*{} Runto Cursor Line Chr+FLO

1-3-21

W Z & O “Parallel Port 2”

1-3-22  “Debug” TH[SE 8

“Debug” I i3 i Hp i — T8 & R DI RE AN 1-3-1 PR,

R 1-3-1 “Debug’ THEHBE THIELINEE

15 % I BE

Run EHMEETT

Stop Z1k

Step BB HAT R T PRECN
Step Over HULHAT BT rRECI — 4484
Step Out H T RBGE 1T 58 f5 Bk T R AL

Run to Cursor Line BATEDEERT

A e, e Step Over” eI T HLL VR, AT LUWEE R P2 1 AR [RPIRZS . anfel 1-3-23

JioR .

[# LED.ASM |
1 ORG OO00H —
2 LINP MAIN Parallel Port 2 |§|
3 ORG 0030H . Part 2 — ;
4 MAIN: CLR P2.0 ;LED1E, 3 its
5 SETB P2.1 ;LEsz‘ZU P2 [E VR
& SETE P2.2 ;LED3 K Pins: [IFE PV
% ACALL DELAYSOOMS ; $E B s00ms
g SETE PZ.0 JLED1K
9 CLR P2.1 ;LEDZE
10 SETB P2.2 ;LED3K
11 ACALL DELAYS00MS ; $E B 500ms
12 SETB P2.0 JLED1ZK
ila) SETB P2.1 ;LED2K
14 CLR P2.2 JLED3E
15 ACALL DELAYS00MS ; $E B 500ms
16 AJMP MAIN
(a)
4 LED.ASM
1 ORG OO00H =
2 LINP MAIN Parallel Port 2 ‘5‘
3 ORG 0030H » Port 2 — .
4 MAIN: CLR P2.0 ;LED1IE, . its
5 SETE P2.1 ;LEDZK P2 0D (VW v
6 SETE P2.2 ;LED3 K Pins: IUxFD VIV TV
7 ACALL DELAYSOOMS ; BE B 500ms
] SETE P2.0 JLED1K
9 CLR P2.1 ;LEDZE,
10 SETE P2.2 ;LED3 K
11 ACALL DELAYSOOMS ; JE BT 500ms
12 SETE P2.0 ;LED1K
13 SETE P2.1 ;LEDZK
14 CLR PZ.2 ;LED3E
15 ACALL DELAYSOOMS 3 BE B 500ms
16 ALIMP MAIN .
(b)

« 21



| sREMERSMA

| " [#] Lep.asM
1 ORG DODOH
2 LINP MAIN Parallel Port 2 X|
3 ORG 0030H . Porl2—? - .
4 MAIN: CLR P2.0 ;LED1R, b I‘I'I'l'l'l'l'l'ls
5 SETE P2.1 ;LEDZ% P2 0B WWMIVIT VIV
6 SETB P2.2 JLED3K Fins: [0FE RV W
7 ACALL DELAYSOOMS ; 3 it s00ms
8 SETE PZ.0 ;LED1°K
9 CLR P2.1 ;LEDZE
10 SETB P2.2 SLED3K
11 ACALL DELAYSOOMS ; 3E it s00ms
12 SETB P2.0 ;LED1K
13 SETE P2.1 SLEDZK
14 CLR P2.2 ;LED3E
15 ACALL DELAYSOOMS ; 3E Bt s00ms
16 AJHP MAIN
(©)

B 1-3-23 3f LED ZF#{TE SRR ES P2 mOMAERRER

(5) AU B T LAY . A Keil #4FF 9 Logic Analyzer” 734 T H AT 5 E
A AR B LS A S Bl . AT View”—“Symbol Window” iy %>, 1] LI #5 7 HE 4
WA EOL. FTLAE 2], LED 33209 P2 i 11 (4 B #0027 47 4% 44 B0 PORT2, A 1-3-24
P

Swmbols
- |
Mugu!ﬁf Marme LDEaEipn T}rped
& -Virtual Registers | | -
- W PPAGE Liong
W XPAGE ulong
L ETAL Llang
W RING Liong
e CLOCK ulang
- PORTO uchar
@ PORT1 uchar
e PORT2 uchar
- # PORT3 uchar
S SOIN Lint
- S00UT Linit
[ e @ GOTIME Lichar
E---Special Functian ...
' o 5P :0x81 Lchar
I N | Cu e T e =

1-3-24 @3t “Symbol Window”i2TNZ&EF P2 ik O E IS 1EEE

E 1-3-25 7R, P74 View = Analysis Windows”—“Logic Analyzer” 54, T &
PLZ R AT . 38 R A AT T LU BDER 1T, AniA] 1-3-26 s,

analysis Windows » | = Logic Analyzer
Trace ¥ | E= performance analyzer
System Wiswer ¥ UF Code Coverage

1-3-25 FTFERIZBED L

0220



MRBEEY Fpl=

Logic Analyzer

etup... || Load... in Time ax Time i am indMax pdate Screen| Transibion 1
Seh Load tdin Ti Ma Ti Grid Z Min/M Update § Tranziti J
Save.. ||| Oz [ 1493398 = | 10ns |[In [[Out] &0 |||Aulu||| Stop || Clear |||F'rev||Nexl|||E

0s [is 0.1 = 01358 =, 4 0.1338 5| =
e |

=]

1-3-26 EHUBES R E D
SURSEATE . B A“PORT2. 0”CRX 3 K/NE) .,
1t “Display Type” ({5 53R NS Prh g #5520 “ Bit” . dnf&] 1-3-28 s, X
FERURIIAS N T 51 P2, 0. IR [FEREA T 1% ol LR IS I P2, 1.P2. 2.

Setup Logic Analyzer &l
‘Eunenl Logic &nalyzer Signals '_ I_)Sl
PORT2.00 |
C ] |
. SignalDisplay —— | DisplayRange ————
Display Type; |* Pax IU 0
Calor: Min: I'J 0

™ Hewadecima Display

Display Formula [Signal & Mask] » > Shift

AndMask:  [TFFrrrTET Skt Right: 1 - Signal Display i~ Display Rang

i~ Export / Impart Display Type I:U’lﬂ:ﬂgﬁ Max ,UxFFi
. . e
Export Signal Definitions... | Import Signal Definitions... | Calor: i Min: 0x0
I Delets actual Signals ™ Hexadeci |

- Display Formula [Signal & Mask] > Shift

kil | e | Hep | bndMask:  [OaomonooT  ShiRghe o
B 1-3-27 & EMZHIG|H B 1-3-28 EEESHEE

S INSEEE . AT Debug”—“Run”fy 4, 7£“ Logic Analyzer” % 1 7] LLE 2G5 01 &
RSP, T B O ERAS 5, v AR RR 78 11— B 8] J5 By “ Stop” %411 15 1132
AR, It Zoom ™ BT AT LAk B T ZEMER A 5 1 X 48, i 1-3-29 iR

Logic Analyzer

Min Time tdax Time Grid | Zoom bl ax |Updats Screen| Transition
Save. ||| 0s  [BB0BSE1s | 02s |[In [[Out[ All]|[Auto][Unds] [Stop | Clear | |[Frev|[Next] [
1 T mi i
FORTE i \ V 1 ‘ i I i |
o) L L) Lo L
i T i T j T | T \
e I [N A A R I
g e L
1 ! ' ' : PORTZ
FORTZ 1 | | | Mouse Pos Referenc
] i | : i Tirne: 55.15921 s /&
\ o — | oo Yalue! o Nf&
105021 = SSI05021 | oy, L — Nia
‘ P |

1-3-29 EFFENRFESHXE

0230



| a5y EERSHA

i M 1-3-29, FTRVEF] L 51 P2, 0.P2. 1.P2. 2 ARUCH B 34 a0 2514
HRFFEOTHIEOK,

Proteus {F EINE

TEFE il i 4 i3 5 R LS - o AR Proteus {5 B XHRE 3 D REHEA 740 L
1. BB ITIE
Ja 3l Proteus fi ELEAF  E A £ T A 1-4-1 iR,

% DUNTITLED — Proteuns 8 Professional — Home Page
File Systen Help
DEES AEEa@EE -~ @

i ————
- {z} Home Page x |

: %~ PROTEUS DESIGN SUITE 8.1

Getting Started

© Schematic Capturs ”~ |Open Project | | New Projact | | Import Legacy | | Open Sample

© PCH Layout ;
= " Recent Projects

i EACS1W EDWED. pdsprj

CADocuments and SettingsWl U emperture SensonDS18820 pdspr

- ChDacuments and SettingshAll Us. . Timer with LCCNS051 Timer. pdsprj

@ Help Home
@ Schematic Capture

1-4-1 Proteus 3 E R mE

AT File”>"“New Project” 4, 84# B 3 L A “ Start " I HE X A9 “New Project” %
L ANEEH O B TR . SURT SR X TEAE . % 8 TR SR AR, WKl 1-4-2 iR, Ao,
il 5 TR A 4 LED. pdspri. (R A7 #4255 Keil TRORAFFEAZAHIE, BI E./C51/LED,
F P AARYE A C A9 oL AT I3

% Hew Project Wizard: Start

Project Heme

Hame |Ll|l pdsprj ‘

Path [E:/C51/LED [ Browse | |

Proteus #R{4E#y
1-4-2  7£ Proteus I ¢ F T8 fEH

W SE R, By “ Next” #241, oF ACGHT TR BB 31t ) 5 i . 2 # “Create a
schematic from the selected template” ¥ % $%2 £l . B M\ 35 % A9 45 M v 1) 22 — A4~ S BRI,
1-4-3 Fi/R .

0240



DEE D |

* Hew Project Wizard: Schematic Design

() Do not create a schematic
(3 Create a schemalic finm the selected emplate

Design Templates
Landscape A0
Landscape A1
Landscape A2
Landzcape 43
Landscape A4
Landscape US &
Landscape US B
Landscape US C
Poitrait A0
Portrait 41
Portrait 42
Paoitrait 43
Portrait 44
Poitrait US A
Porrait US B
Paitrait US C
Sample Design

C:A\Documents and Settings\All Users\application Data\Labeenter Electronics\Prateus 8 . A\DEFALLT.OTF

1-4-3 EFIRFREEEITESREPEFEIE—REER

B “Next” ¥ 4T F — 4, % $E“Do not create a PCB layout”, Bk A 41 PCB
B, P Next" e Hl#E 7 F —#, #4#5“No Firmware Project”, FjHs“ Next"# £l #E 17
T—#, B Finish”$2 41 R H E 05 B T REG 52 8E , (iRl 1-4-4 fios .,

*~ Hew Project Wizard: Summary

Sunmary

Saving As.  E:\CSIMLEDVLED. pdsprj
v Schematic

Lagont

Firmware

Tetails

Schematic template: C:'Documents and Settings'#11 Users'Application Data‘Labcenter
Electronies‘Froteus 8 Professional\Templates\DEFAULT. DIF

Ho ECE layout

Fo Firmware Froject

1-4-4 FIECIETERE
2. IR ERIEE
JA 8l Proteus 8 Professional Zf4:, 5t H JU B ] 32 AL 1T , Wil 1-4-5 B .

0250
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~ LED - Proteus 8 Professional — Schematic Capture FEX
Filel Edit Yiew Tool| Design Graph Debug Librery Tesplate  Systes Help

DEES QEDEAER=|0 B+ +QQ4Q 9 (k00 TEEAN QL RS
ALY Al Sl

X c
)
078

-

L2 (P[]

* v

TEfF R 4
P(pick)

TENE S ®@OE v | i E

P I Il M | © HoMessages | Rootsheet1

1-4-5 Proteus 8 Professional 5 IE &+ R

H AT IO IR RS AR TT RS IN B ST RS R b . Bl TR R AL P (piclO) 7
P TR SRS L AniEl 1-4-6 IR .

& Pick Devices ‘EHXI

Keywords: Feesuls [No Fiker} Schematic Preview:
[ |
Match Whole Words? O
Show anly parts with models? [

Device

{Nothing selected for previen]

Capacitors
CMOS 4000 series
Connectars

Data Converters
Debugging Tools

Diodes
ECL 10000 Series
Electromechanical

Inductors

Laplace Primitives

Mechanics PLB Freview
Memony ICs Mo seaich cietia

Microprocessor Cs Please enter one of more keywords and/or

Miscelancous select a Category, Sub-categony of Manufacturer

Modsling Primitives
Operational Amplfiers
Optoslectionics

Sub-calegory:

Marufacturer.

‘ ‘ il Cancel

1-4-6  THEFEED

1E7E LAY Keywords” SCAE H A F5 2RI TCIF 24 AR P A5G HE 5 AN 1-4-7 IR

F.aywards:

Mateh whole Words?
1-4-7 HNKEFIERFETH

T Proteus AR SZH5 STC RA 08 7 HLOT B, K L B3 25 /5 AT89C52, ik
Ah BB B (Resistors) B8 % Y6 —H4 (LED-YELLOW) . % A 4 %4 FR S8 ToAE IR 35 S
TR ABAS Wbk A SEFE ) 24 FR i A AH R SR It BE R 2 X N A e . 9, FE SCAS HE Hh

0260



wminapn gz

A“89C52” A4 LN 25 58, unE 1-4-8 fiw,

ATBSCE2 Preview
YSM DLL Model [MCSBOST DL
bit =

Subrcalegory

‘ ‘ [piLan ~

oK Cancel

< I |

(2

1-4-8  HINKEFSICS2" IR T T4

e BRI R 4 R PG 5 BT 2T 2w A i B 87 1 MR T 51 R X
[, 5 A “RES”, 28 FH ; 5 A “LED”, %8 “LED -YELLOW”, X #£, AT89C52 ., HiBH .
B OO TINS5 O MR RS R X

3. LI R E

TETCIFPIRIX it i AT89CS2 LR B A M 4 B 7 1 P LA T AR, 5
i S AT R B> AT89CS2 JBREI RIAE R, ] LIRS 3l . REOEHRES 251 1 07 B . 5
v SR BRI B e . 35 X ATk AR YUCORE 2 A DL 31 2 1A 2 B 7 101 A9 5 T 2 L
Kl 1-4-9 Firs .

........................ BRI b R3
1 U)] + + et ctalr—e + + | 1 + + 1Dk il } 1 } + 1Dk i il 1 1t + 1Dk }
ot I e S e AT O i Y Tl 5 LT T I o L) 28 55 v o 2 IV 70 SO £ T, o S I %7t I N S
1k JL’HT.&LT PO.0/ADO 865 A A e
1 i PD‘1:AD1 Jﬁ- ..................
] . EnSIENEEE NN R
1 i Pﬂ_‘}’m —35— }—4 1 I 1 N (SN S NS N S N N NS S0 CUN S S S S — — — 1 i 1 1 1
[ Eg':j:gg_ai 2 O DT 7] B
IS Ve POTIADT ol i LED-YELLOW LED-YELLCIA; Y LED-YELLOW
[T i | [ [ [ | [ [ ] [drexga | [T T g | | [ 11 [ dvewns | [
-+, I T O O
o P21/m3 (22 e
e P2 210 23! ==l i e s S R e e e
=] o [t - |
A e P22 i o e e e
i L EA P2.51|I1a|13 —25— ................................
—1 I Pz_BrA14 —21 .........................
— FZ.?-’;&_’AS .....
| L] P1 02 P3.0RYD s onc 10 5 A 1T 0 T T o S e O
| 2] P11 TIEX P3»-|@J.L |58 S S O I T T A S A S S T A
! —j: P12 P3.20NTD [—
BEE S T D A A A A
- Pl 4 Paamn —-
S s PasT [—L
| L7 P16 Pﬁﬁmji ..................
Rz PaTRD [
I - o I 5 I 5 5 5 5 5 55 6 6 5 5
| =TEXT=
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| 2EyEESHA

TR BN R TR A 0T o S DL L EA T O/ /0N I P 2 LD DA v L BEAT O/ i /s 2
V] 2t 7 1 A R 8 2 LR A T 7 10 ke 9813 4 PRl i L T 1 A TS R . AR TS 7
RS Bl (5 75 AE (043 5 BV AT Bl 22 1) 2 6 11 ) ] ALY L

N T TR A B T R R A B T 1. N AE LB RT AR A ol A0 AT 1-4-10
7R

Edit Label
Tlelete Lahel

. Drag Object

Edit Froperties Ctrl+E
9| Delete Object

~  EBotate Cloclwise Hum—
Rotate Anti-Clockwize

Rotate 180 degrees

I-Mirroer

B 1-4-10 ZEFEfH RI LA HGRES S

HFE“Rotate Clockwise” 4>, ¥ R1 B & e s . [P, R2.R3 ¥kt Jy i i
ﬁ[ﬂ 9-)[1[”5] 1_4_11 F)‘["/—-‘?\‘o

1-4-11 §FFE R1.R2,R3 #HATIRA iR R R 24 B RiEE O

PRk R, PR ORI T BAL P S AR, B POWER CHLIED ™ B H 8
BLEIX A 1-4-12 s,

o28.
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1-4-12 FMBEBEEHLBERERO

FHHEATEL . ROCAREE L IO B — S OERR Y ET B ARAE g 2k @ L e on T LLIE
2o H Iz PRI BB RS 200 — DRI — i, SRl PR TR] I SR I B T AR e
BrAi 2% (IA 0 Proteus B4 85 AL E BOASR HE LI, Br LA 4 R HLES I 950 . i
258 BRI 2 R LT VAN 1-4-13 B

1-4-13 ELRTEMNGERERNO
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N E AT BCE A TS BT S g R T B TR AE L A 1-4-14
IR o ORI “ARAE S LR /N 10 mA ZeAy Bt AR HEL R R 200 Q.

55 Edit Component

Part Reterence: |FH ‘ Hidder: []
Fiesistance: |2UU ‘ Hidden: [7]
Element: Mew

Madel Type |ANALDG vHHlde Al v\

PCB Package: |HES4U

Other Properties:

v|[2] Hideal

[ Exclude fram Simulation
[ Exclude from PCE Layout
[ Exclude from Bill of Materials

[ Attach hierarchy module
Hide common pinz
[ Edit all properties as text

([}
=

LCancel

1-4-14

RS H% B XHEIE

Wit B R AL AT89CS2 . it i PR HILS B0 B X HEAE . &l 1-4-15 s,

i5is Edit Component

Fait Feference: ‘U1 | Hidder: []
Part ¥ alue: ‘ATESEEZ | Hidder: [] Help
Element; Hew
PCE Package |DiL40 (2] [Hidean (] | [ Hidden Pins |
Prodiam e \ 1= [ide an | | [Eait Eimware ]
Clock Frequency: ‘12MH2 | | Hide &l s |
Advanced Properties: -

Enable trace logging v H Mo ~ | | Hide All 9_|

Other Properties:

[ Exclude from Simulation
[ Exclude from PCE Layout
[ Exclude from Bill of Materials

[ &ttach higrarchy module
Hide comman pins
[C1Edit all properties as text

1-4-15

Hiifi“Program File” SCAHE J5 T8I Y 18 b » 65 2 AT B BE T - 3 A S 4 A9 R P “ LED.

hex”, Wl 1-4-16 s,
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mrern gz

stEAD [5m ¥ of e m
iR~ | Folv| M | e EE |
; (B 2015-1-18 11°53
HRIARI
L1
AT
IR
PSR
I#EW | ~ [FRo |
FHEB @ [Program files ~ [(mE ]

B 1-4-16 S AFEF“LED. hex”

4. (FEER
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